NHCTCA Conference
September 11 -13, 2019

William Gardner, Secretary of State
David Scanlan – Deputy Secretary of State
Anthony Stevens – Assistant Secretary of State
Bud Fitch – Assistant Secretary of State/Election Legal Counsel
Deb Cornett – Director of Election Training
Colleen McCormack – ElectioNet Office
Debra Unger – ElectioNet Office
Chart Your Course – Deb Cornett

- Clerks Only – Chart Your Course
- Fast Track your ElectioNet Knowledge – Email to follow for sign up
- Training Classes Start:
  - September 24 & 26
  - October 1,2,3,7,8 & 9
200th Anniversary of the NH State House
Fall NHCTCA Conference 2019
SOS Theme for the Next Clerks’ Conference

- 20/20 Vision
  - aka SCORE/SCORE for the older generation!
Best Regional Attendance EVAH!!

Attended 2019 Regional
187 Towns/Cities
354 Attendees
Red = Unincorporated Places
Why Cyber Security Training is so Important!

- The State of New Hampshire has invested in state of the art cybersecurity to protect election integrity.
- However, any one ElectioNet user can compromise the Statewide Voter Registration Database.
- Therefore, YOU are the last line of defense.
- Hackers are aiming for election officials.
  - Small towns are a target
  - Hackers are patient and have all the time in the world.
  - They will try for months to find an entry point and wait for the appropriate moment to use the information.
Cyber Security Essentials
SANS – Security Awareness On-line Training
Email will come from Daniel Cloutier<noreply
ElectioNet Password Security

☑ Never give out your ElectioNet password OR user name – we will never call and ask you your user name or password.

☑ Two Factor Authentication ElectioNet Login now requires the new “2FA”
   - Email notice went out that 2FA started June 17th
   - 2FA authenticates you as a user with a unique code
   - ElectioNet -> Help -> Instructions -> 2FA – Two Factor Authentication
2FA Statistics (Cyber)

- 1164 users in ElectioNet when we started in June
- 1152 current users in ElectioNet as of 9/04
- 699 Verified 2FA
  - 421 Not Verified
    - 32 No New RAE on file

We are up in the back of the room to help you get verified in ElectioNet
  - You will need your cell phone or can receive your emails on your cell phone
Notify Us When ElectioNet Users Leave (Cyber)

☐ An ElectioNet user who no longer is in office is a hole in our line of defense.

➢ 92 – No longer in Office = 66 Towns/Cities
➢ 31 – Disabled on Purpose
Notify Us When ElectioNet Users Leave(Cyber)

- Keep all of your election officials up to date in ElectioNet
  - ElectioNet -> Help -> Instructions -> Election Official Information
- Notify the ElectioNet Help Desk immediately when a user is no longer in office.
- Otherwise we could be potentially sending emails to users who may open the gate to our Statewide Voter Registration System (SVRS)
Antivirus & Operating Systems (Cyber)

- Keep your Windows operating systems current
- Install proven Anti-Virus Software

*Do not respond to ads like this:*
Access Emails Before You Open or Respond (Cyber)

- Be sure each email is legitimate!
- Use the “Preview” pane setting in your email configurations
  - This allows you to “Preview” emails prior to opening them
  - In Outlook the settings are:
    - Click on the “View” tab
    - Go to the “Reading Pane” and select where you want to view the
Preview Pane (Cyber)
Place your mouse/cursor over an email link and it will display the information contained in that link (hovering). Sometimes the type written words do not match the actual information contained in a link. By doing so you will see who the emailer actually is and/or where it will go.

If you are not sure:
- Contact the person or company directly
- Delete the email

Common feature of a phishing email to watch out for:
- They weren’t “expected” or “asked for” emails
- They are asking for money
- They often have a sense of urgency to them
- They try to trick you into clicking an incorrect link
- They try to steal login credentials by asking you to log in to a fake form
- They often threaten to disable your account or block an activity
- They may contain misspellings or bad grammar
- They seem very, or just a little, weird and/or unusual
Hover to Discover
Protecting You & Your Voters (Cyber)
Phishing
Ransomware

- **Ransomware** is a type of malicious software designed to block access to a computer system until a sum of money is paid.

- Recent ransomware attacks are targeting local governments in New Hampshire.

- **Prevention** is the most effective defense against ransomware.
  - Back up your checklist
  - Attend Cyber Security awareness and education
  - Define a Cyber Security incident response plan
The town manager of a hamlet in south eastern New Hampshire has defied demands that he pay a ransom to recover police department computer files taken hostage by Cryptowall, a newer piece of malware that encrypts hard drive contents of infected machines until victims pay for them to be decrypted.

"Make no mistake, the Town of Durham will be paying no ransom," Town Manager Todd Selig was quoted as saying by CBS Boston news. Police department computers for the town of almost 15,000 residents were reportedly infected Thursday after an officer opened what appeared to be a legitimate file attachment to an e-mail. By Friday morning, widespread "issues" were hitting the department computer network. It was shut down by noon that day to prevent the infection from spreading to other systems.
Monitor for Election Disinformation

- How do you know if the news is “disinformation”? 
  - Disinformation is when someone maliciously puts wrong information about when/where/how to vote or election results in the news or social media.
  - Disinformation undermines voter confidence

- Example: AP election night reporting
  - US Senate Intelligence Committee reports concerns that AP results may be hacked causing the wrong results to be displayed on the news or website.

- If you observe that the results are not what you submitted to the SOS office, immediately notify the Attorney General and SOS office.
Monitor for Election Misinformation

- How do you know if the news is “misinformation”?
  - Misinformation is when someone forwards wrong information about when/where/how to vote or election results in the news or social media.
  - The person does not know the information is false.
  - Misinformation undermines voter confidence

- Example: Town of Bow
  - Voter came in asking for birth certificates for her and her husband
  - Clerk inquired why they were needed
  - Voter stated she was getting a “Real ID” because she did not want to lose her voting rights.
  - Town clerk said there was no such law, but she was going to call the SOS office to verify.
    - Town clerk believed it carries more “CLOUT” when you can say the SOS office confirms

- If you hear “misinformation” correct it as quickly as you can.
Please Remember:

- YOU are the last line of defense.

- Hackers are aiming for election officials.
  - Small towns are a target
  - Hackers are patient and have all the time in the world.
  - They will try for months to find an entry point and wait for the appropriate moment to use the information.

- Please use what you have learned to protect yourself, your voters, and New Hampshire elections.
Cyber Incident Reporting

“If you see something, say something!”

Notify the Attorney General and Secretary of State.
Voter List Backups in the Event of a Security Incident

- We are a paper state and we will still conduct the election.

- Each **month**, save an Alpha Voter list locally to your computer for backup
  - ElectioNet -> Reports -> Voters -> Alpha Voter List
  - Make a folder on your computer for easy access

- **Starting 8 weeks prior to any election;**

- Each **week**, save the **Checklist** locally to your computer
  - Reports -> Elections -> Checklist
  - Make a folder on your computer for easy access
Marked Checklist to Archives 2020

- RSA 659:102 – Reminder!!!
- “Within 90 days of the closing of the polls for each regular state general election and for each presidential primary.....shall send one copy of the marked checklist...to the state archives...”

- Always send the “check-in” marked checklist
- DO NOT FORGET TO MAKE A COPY FOR YOUR OFFICE
Duplicate Voters

- 02-09-2019 we started with 22,410 Duplicate Voters
- We did an extensive search with matching exact last and first names and a DOB
- We still left it up to the towns to determine if the voters were a match
- You have merged 8,157 Duplicate Voters as of 08-20
- KUDOS to you all!
Current Voter Registration Documents

- Voter Registration Form
  - July 2016
- Domicile Affidavit
  - 03/2017
- Qualified Voter Affidavit
  - Identity, Citizenship or Age
  - 10/2017
LEARN – Online Clerks Course

- Learning
- Elections
- And
- Responsibilities
- Network
LEARN – Online Clerks Course

- 15 Clerks were recertified in the new course
  - Largest group since its conception.
- Will be available online for anyone with clerk duties.
  - We will email everyone when it becomes available.
  - There is a letter from Bill Gardner on your tables.
- In the future, we are working on a module for the Ballot Clerks.
Absentee Ballot Affidavit Envelopes - NEW

- Absentee Envelopes are ALL the same size
  - Paper and Accuvote towns and cities
- **NEW** Affidavit Envelopes – added wording
  - Form A – Regular absentee ballots
  - Form R – UOCAVA absentee ballots

**NOTE:** 2020 Order Forms for ALL of the envelopes will be sent from the main office next month
**STATE OF NEW HAMPSHIRE – STATE ABSENTEE BALLOT**

**Absence from City or Town.** A person voting by absentee ballot because of absence from the city or town in which he or she is entitled to vote shall fill out and sign the following certificate. I, ___ [Name], age ___, ____, of ____ [City or Town], New Hampshire, do hereby certify under the penalties for voting fraud set forth below that I am a voter in the city or town of ____ [City or Town], New Hampshire, in ward ___, that I will be unable to appear at any time during polling hours at my polling place because I will be working on election day or I am voting on the Monday immediately prior to the election, the National Weather Service has issued a winter storm warning, blizzard warning, or ice storm warning, and I am elderly or infirm, have a physical disability, or have to care for children or infirm adults, or I will be otherwise absent on election day from said city or town and will be unable to vote in person. For the purposes of this certification, the term “working” shall include the care of children and infirm adults, with or without compensation.

I certify that I have carefully read (or had read to me because I am blind) the instructions forwarded to me with the ballot herein enclosed, and that I personally marked the ballot within and sealed it in this envelope (or had assistance in marking the ballot and sealing it in this envelope because I am blind).

**Signature**

Print Name

**Absence Because of Religious Observance or Physical Disability.** A person voting by absentee ballot because of religious observance or physical disability shall fill out and sign the following certificate. I, ___ [Name], age ___, ____, of ____ [City or Town], New Hampshire, in ward ___, that I will be observing a religious commitment which prevents me from voting in person or that on account of physical disability I am unable to vote in person.

**Signature**

Print Name

**A person assisting a disabled or blind voter shall make and sign a statement on this envelope in the space provided acknowledging the assistance.**

I attest that I assisted the applicant in executing this form because he/she has a disability.

**Signature**

Print Name

In accordance with RSA 659:34, the penalty for knowingly or purposely providing false information when registering to vote or voting is a class A misdemeanor with a maximum sentence of imprisonment not to exceed one year and a fine not to exceed $2,000. Fraudulently registering to vote or voting is subject to a civil penalty not to exceed $5,000.

Form A 9/19
Absentee Ballot Affidavit Envelopes

- **Destroy**
  - Paper towns – ALL small envelopes
    - Regular = A, B & C
    - UOCAVA = E, F & UOCAVA-p
  - Accuvote towns
    - Regular = Form O
    - UOCAVA = UOCAVA-a
2019 FPCA is good for the 2020 Presidential Primary

2020 should be a new FPCA

- Best Practice
- Reach out to 2019 UOCAVA voters to send a new FPCA
UOCAVA – 45 Day Deadlines

- Always a Saturday – HAVA law
- Presidential Primary – TBA
- State Primary – July 25th
- State General – September 19th
- Make sure you have coverage for these days.
  - We send out reminders by email
  - ElectioNet Log-in Screen banner reminders
  - Enter **ALL** UOCAVA requests before these dates
  - ElectioNet office is open in the afternoon, we make phone calls.
  - If the requests are not in ElectioNet, we cannot help you.
UOCAVA – 45 Day Deadlines
FPCA – New as of 4/2019
Voter Registration and Absentee Ballot Request
Federal Post Card Application (FPCA)

Print clearly in blue or black ink, please see back for instructions.

1. Who are you? Pick one.
- I request an absentee ballot for all elections in which I am eligible to vote AND:
  - I am on active duty in the Uniformed Services or Merchant Marine -OR- I am an eligible spouse or dependent.
  - I am a U.S. citizen living outside the country, and I intend to return.
  - I am a U.S. citizen living outside the country, and my intent to return is uncertain.
  - I am a U.S. citizen living outside the country, and I have never lived in the United States.

<table>
<thead>
<tr>
<th>Last name</th>
<th>First name</th>
<th>Middle name</th>
<th>Suffix (Jr, II)</th>
<th>Sex</th>
<th>Sex</th>
<th>Date of Birth (MM/DD/YYYY)</th>
<th>Driver’s license or State ID #</th>
</tr>
</thead>
</table>

6. What additional information must you provide?
Puerto Rico and Vermont require more information, see back for instructions. Additional state instructions may be found at FVAP.gov. You may also use this space to clarify your voter information.

I would like this request be for the year 2020

FPCA – New as of 4/2019
FPCA - UOCAVA

U and O

Military
(including spouse, dependents)

Domestic

Overseas

FULL BALLOT

C and A

Citizens

Intend to return

Not certain or Never resided

FULL BALLOT

V and A

Absentee Voter

Act

FOO BALLOT
UOCAVA Flow Chart
Uniformed and Overseas Citizen Absentee Voting Act

1. Town/City Clerk's office receives a Federal Post Card Application (FPCA)
   - Date stamp it upon receipt. This date becomes the UOCAVA start date and Absentee Ballot Request Date.
   - Retain a copy of the FPCA in your FPCA folder.
   - A copy of the FPCA goes to the Supervisor of the Checklist.

2. Did the applicant provide all the information required on the FPCA form?
   - YES
     - Flag as UOCAVA voter and add absentee requests for all elections they are eligible for.
   - NO
     - Contact applicant for missing information from the FPCA.

3. Is the applicant's voting residence within your town/city ward?
   - YES
     - Enter voter as “Pending”, flag as UOCAVA and add absentee requests for all elections they are eligible for.
   - NO
     - Reach out to the voter for the voter to contact the town/city ward they are a registered voter in.

4. Is the applicant on the checklist in your town/city?
   - YES
     - Send applicable ballot for each eligible election.
   - NO
     - Flag as UOCAVA voter and add absentee requests for all elections they are eligible for in ElectionNet.
An FPCA may be a request for an absentee ballot and/or a voter registration application.

- Check the Uniformed and Overseas Absentee Voting Act (UOCAVA) box.
- Date stamp the FPCA the day they are received, this becomes the "UOCAVA Start Date". Election/Her automatically pre-fills the "UOCAVA End Date" with 12/31/2020.
- UOCAVA voter requests are good for one calendar year. *Exception: Presidential Primary year.
- Upon receiving the FPCA, select in Election/Her all the elections for which a UOCAVA voter is eligible.
- Categories (a) and (b) receive regular absentee ballots ("if Military, Select Domestic or Overseas.")
- Categories (c) and (d) receive Federal Ballots Only. Check both the "UOCAVA" & "Federal Office Only Ballot" boxes.
- If FPCA is a new voter application - Use Your Name, NH as their Birthplace, since the FPCA does not have a field for Place of Birth.

Example: Absentee ballot mailing address for a military person

Call the Help Desk: 1-800-548-5954 if you have any questions.
An FPCA may be a request for an absentee ballot and/or a voter registration application.

- Check the Uniformed and Overseas Absentee Voting Act (UOCAVA) box.
- Date stamp the FPCA the day they are received, this becomes the “UOCAVA Start Date”. ElectioNet automatically pre-fills the “UOCAVA End Date” with 12/31/2020.
- UOCAVA voter requests are good for one calendar year.*Exception: Presidential Primary year.
- Upon receiving the FPCA, select in ElectioNet all the elections for which a UOCAVA voter is eligible.
- **Categories (a) and (b) receive regular absentee ballots.** *(If Military, Select Domestic or Overseas.)*
- **Categories (c) and (d) receive Federal Ballots Only.** Check both the “UOCAVA” & “Federal Office Only Ballot” boxes.
- If FPCA is a new voter application - Use Bean’s Grant, NH as their birthplace, since the FPCA does not have a field for Place of Birth.

An absentee ballot is also available to: **Military, Spouses and Dependents**

Federal Office Only Ballot:
- U.S. Citizen residing outside the United States and return is not certain
- U.S. Citizen and have never resided in the United States

*Note: UOCAVA must also be selected for Federal Office Only Ballot*

Acceptable Voter Registration Information:
- Name
- Address
- Date of Birth
- UOCAVA Start Date
- UOCAVA End Date
- Voter ID
- Military, Spouses and Dependents
- E-mail

Acceptable Absentee Ballot Information:
- Name
- Address
- Date of Birth
- UOCAVA Start Date
- UOCAVA End Date
- Voter ID
- Military, Spouses and Dependents
- E-mail

Note the Absentee Ballot Requested in the Voter Record

For More Information, Contact: 1-800-325-VOTE (8683)
When an “Undeclared” UOCAVA voter declares a party for their absentee ballot:

- Best practice is to insert a “Return to Undeclared” form
- Mail – Insert it with the absentee ballot
- Email – Attach PDF of the form
Federal Write-In Absentee Ballot (FWAB) - Process

1. Enter the request for an absentee ballot into ElectioNet.
2. Date stamp it upon receipt. This date becomes the UOCAVA start date and Absentee Ballot Request Date.
3. A copy of the FWAB goes to the Supervisors of the Checklist.
4. Retain the FWAB; send the voter the appropriate ballot along with an FPCA.
5. Retain a copy of the FWAB for your FPCA folder.

Is the applicant a registered voter?

- YES: FWAB is considered a request for an absentee ballot. Send the appropriate ballot. Enter in ElectioNet:
  - Voter Registration
  - Absentee Ballot
  - Flag as UOCAVA

- NO: FWAB will only be counted if there is a signature on a previous voter registration form. RSA 657:23

Did the voter return the ballot?

- YES: Clerk or Supervisor verifies signature
- NO: Bring the ballot and FWAB to the polls.

Did the applicant return the ballot and FPCA?

- YES: Enter in ElectioNet:
  - Voter Registration
  - Absentee Ballot
  - Flag as UOCAVA
- NO: Previous signature is on file, the FWAB becomes the voter registration form.

FWAB is to be rejected by the Moderator and the voter must be notified within 7 days. RSA 657:23
2020 Election Budget

- Minimum of **FOUR** elections
  - Presidential Primary
  - Local/Municipal
  - State Primary – Day after Labor Day
  - State General
2020 Elections

- Film – we still have 2017 film
- It WORKS!
  - We will be in the 10th Mountain Room to take your picture with our “Thinking Caps”
  - Come and get on our “Board” to “Chart your course for 2020”
2020 Elections

- I voted stickers - we gave them all out.
  - If you have any extra, please share with towns that did not receive any.

- 10th Mountain Room
  - Absentee Ballot Boxes are in the
  - Screens – table top voting booths

- Come and get them after the presentation
Election Booths Needed

Do you know how many polling booths are needed in 2020 for:

- The Presidential Primary election?
  - One for every 150 Voters
- The State Primary election?
  - One for every 150 Voters
- The State General election where votes will be cast for a president
  - One for every 100 voters
Bud Fitch – Assistant Secretary of State

- Discussions:
  - Assistant Clerks
  - Checklist Fees - Hand out
  - UOCAVA Military Spouses – Federal Update
  - Absentee Ballot Delivery Agents – Updated Form for delivering to Clerk – Hand out
  - Cybersecurity – Legal overview/summary
Assistant Clerks

The town/city clerk is legally responsible for the conduct of each member of the clerk’s office when the assistant is carrying out the Clerk’s duties.

- Deputy Clerks have specific statutory authority and responsibilities in specific circumstances.
- A Deputy or Assistant Clerk, otherwise, has just those responsibilities and authority granted to them by the Clerk.
- For voter registration, absentee voting, filing for office, and any other election related duty, the clerk should give an assistant authority and responsibility to act on the clerk’s behalf only after training the assistant.
  - Ensure the assistant understands the law and how to properly assess the sufficiency of evidence of qualifications for voter registration (proof of domicile, age, identity, and US Citizenship).
  - Ensure the assistant knows how to properly complete all tasks the assistant is authorized to perform.
An assistant clerk may sign the voter registration form as “Received by” if all of the information on the form has been presented to them. (Proof of domicile, age, identity and citizenship)

If a voter needs to sign a domicile affidavit or a qualified voter affidavit, then the “Assistant Clerk” must be a notary public or a justice of the peace to sign the affidavits.

The law authorizes only election officers, notary publics, and justices of the peace to witness oath taking.

652:14 Election Officer. – "Election officer" shall mean any moderator, deputy moderator, assistant moderator, town clerk, deputy town clerk, city clerk, deputy city clerk, ward clerk, selectman, supervisor of the checklist, registrar, or deputy registrar.

Assistant Clerks are not included as an “election officer.”
Federal Updates to Legislation

- New Federal Law applies to domicile for Military Spouses Only
  - Rare circumstances. If a person seeks to register who is a spouse of a service member who has never been domiciled in New Hampshire, contact the help desk – we will assist you.
The “public checklist” and a “marked checklist” are two distinct governmental records.

Different fees apply for a copy.

The statute setting a fee for the “Public checklist” does not apply to the fee for a copy of a “marked checklist.” The town or city’s usual fee per page for a copy of a public record applies. RSA 91-A:4, IV. “[T]he person requesting the copy may be charged the actual cost of providing the copy . . .” RSA 91-A:4, IV.

The marked checklist does not fall within the definition of a “public checklist” established in RSA 654:31, I(d). That section addresses the current checklist reflecting the “most recent” additions and removals made by the supervisors. The marked checklist from past elections is an historical record of who was a registered voter as of the end of that election day and who is marked as receiving a ballot or voting by absentee ballot.
“Public checklist" means the checklist required by RSA 654:25 which contains the names of voters who by law are to be listed on a checklist available to the public in accordance with the restrictions established by this section.” RSA 654:31, I(d).

The law prescribes a fee for a copy of the most recent “public checklist,” for a town or city of $25, plus $0.50 per thousand names or portion thereof in excess of 2,500, plus any shipping costs.” RSA 654:31, II. The Right-to-Know law explicitly provides that when a statute establishes a fee by law, that fee applies, not the usual “actual cost of providing the copy.”

“Nothing in this section shall exempt any person from paying fees otherwise established by law for obtaining copies of governmental records or documents, but if such fee is established for the copy, no additional costs or fees shall be charged.” RSA 91-A:4, IV.
657:17 Procedure by Voter.

The absentee ballot shall be delivered to the city or town clerk from whom it was received in one of the following ways:

(a) The voter or the voter's delivery agent may personally deliver the envelope; or

(b) The voter or the person assisting the blind voter or voter with a disability may mail the envelope to the city or town clerk, with postage affixed.
II. As used in this section, "delivery agent" means:

(a) The voter's spouse, parent, sibling, child, grandchild, father-in-law, mother-in-law, son-in-law, daughter-in-law, stepparent, stepchild; or

(b) If the voter is a resident of a nursing home as defined in RSA 151-A:1, IV, the nursing home administrator, licensed pursuant to RSA 151-A:2, or a nursing home staff member designated in writing by the administrator to deliver ballots; or

(c) If the voter is a resident of a residential care facility licensed pursuant to RSA 151:2, I(e) and described in RSA 151:9, VII(a)(1) and (2), the residential care facility administrator, or a residential care facility staff member designated in writing by the administrator to deliver ballots; or

(d) A person assisting a blind voter or a voter with a disability who has signed a statement on the affidavit envelope acknowledging the assistance.
III. The city or town clerk, or ward clerk on election day at the polls, shall not accept an absentee ballot from a delivery agent unless the delivery agent completes a form provided by the secretary of state, which shall be maintained by the city or town clerk, and the delivery agent presents a government-issued photo identification or has his or her identity verified by the city or town clerk. Absentee ballots delivered through the mail or by the voter's delivery agent shall be received by the town, city, or ward clerk no later than 5:00 p.m. on the day of the election. A delivery agent who is assisting a voter who is blind or who has a disability pursuant to this section may not personally deliver more than 4 absentee ballots in any election, unless the delivery agent is a nursing home or residential care facility administrator, an administrator designee, or a family member, each as authorized by this section.
New Absentee Ballot Return Form HB 531

- RSA 657:17 – “Delivery Agent”
- ElectioNet -> Help -> Instruction -> Absentee Ballot Return Form Effective 09-17-2019
654:45 Centralized Voter Registration Database. –

I. The secretary of state is authorized to plan, develop, equip, establish, site, and maintain a statewide centralized voter registration database and communications system, hereinafter referred to as the voter database, connecting users throughout the state.

V. The secretary of state shall:

(b) Provide adequate technological security measures to deter unauthorized access to the records contained in the voter database.
(c) Issue guidelines to implement the voter database.
Cybersecurity – Legal Overview

Cybersecurity Efforts Include:

- **Penetration Testing** – Expert vendors routinely test the safeguards in place that protect the system from unauthorized access;
- **Specialized Software and contract monitoring services** designed to detect and report unusual activity;
- **Specialized Software** that monitors electronic traffic
  - Software has the capacity to segregate known threats/possible threats for human assessment
- **Dark Web and Internet monitoring** for evolving threats
- **Elections Division Staff** routinely monitoring activity in ElectioNet
- **Protecting You and Your Voters** – included in today’s training, SANS on-line video training, and training delivered locally to election officials who have not attended training.
Secretary of State
William M. Gardner
Thank you for all you do!